
Roland software Package

Installation and Setup Guide

This document describes the Roland Software Package CD-ROM and explains such matters as how to
install and set up the programs included on it.



Thank you very much for purchasing this product.

• To ensure correct and safe usage with a full understanding of this product's performance, please be sure to read through this manual
completely and store it in a safe location.

• Unauthorized copying or transferral, in whole or in part, of this manual is prohibited.
• The contents of this operation manual and the specifications of this product are subject to change without notice.
• The operation manual and the product have been prepared and tested as much as possible.  If you find any misprint or error, please inform

us.
• Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may occur through use of this product,

regardless of any failure to perform on the part of this product.
• Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may occur with respect to any article made

using this product.



1Roland Software Package Installation and Setup Guide

Table of Contents

Windows® and Windows NT® are registered trademarks or trademarks of Microsoft® Corporation in the United States and/or other countries.
Pentium is a registered trademark of Intel Corporation in the United States.
Other company names and product names are trademarks or registered trademarks of their respective holders.

Copyright © 2004  Roland DG Corporation http://www.rolanddg.com/

Table of Contents ............................................................................................................. 1

1 System Requirements .................................................................................................. 2

System Requirements for Installing the Software ................................................................................. 2
System Requirements for USB Connection .......................................................................................... 2

2 Installing and Setting Up to the Software ................................................................... 3

Software Included with the Machine ..................................................................................................... 3
Windows XP .......................................................................................................................................... 4
Windows 98 SE/Me/2000 ...................................................................................................................... 7
What to Do If Installation Is Impossible ................................................................................................. 9

3 Uninstalling the Driver ................................................................................................ 11

Windows XP/2000 ............................................................................................................................... 11
Windows 98 SE/Me ............................................................................................................................. 13

4 Viewing Online Help ................................................................................................... 14



2 Roland Software Package Installation and Setup Guide

1 System Requirements

System Requirements for Installing the Software

System Requirements for USB Connection

• The ability to make a USB connection depends on the specifications of the computer. To determine whether the
computer you're using is capable of correct USB operation, check with the manufacturer of the computer.

• Use a shielded USB cable having a length of 3 meters or less. Do not use a USB hub or the like.

Operating system

Computer

Drive

Monitor

Memory (RAM)

Free hard-disk space
required for installation

Interface

Windows 98 SE (Second Edition)/Me/2000/XP

Computer running Windows (Pentium processor or better recommended)

CD-ROM drive

Windows-compatible monitor capable of displaying 256 colors or more

32 MB or more recommended

32 MB

USB port

Operating system

Computer

Windows 98 SE (Second Edition)/Me/2000/XP  (Windows 95 and Windows NT4.0 are not
supported.)

1) Computers preinstalled with Windows 98 SE/Me/2000/XP at the time of purchase
(This includes such computers later upgraded to Windows Me/2000/XP.)

2) Computers on which USB operation is assured by the manufacturer of computers
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2 Installing and Setting Up to the Software

Software Included with the Machine

These programs support only three-axis engraving using the X, Y, and Z axes.

This program is for free cutting three-dimensional shapes. You can not perform designing
using this program alone. MODELA 3D Design and MODELA 3D Text are included.

This program is for flat engraving of nameplates and the like. It can use any TrueType fonts
registered with Windows. It also comes with its own stroke fonts. You can even import images
and engrave items such as logos. There is even a feature that lets you import data from a list of
names and engrave nameplates one after another.

This program is for designing and engraving reliefs (raised engravings). This lets you easily
add thickness to text, shapes, and imported images, and create three-dimensional reliefs.

This program is for performing simulations before you actually carry out cutting using 3D
Engrave or MODELA Player. It lets you verify the finished results for shapes, the time re-
quired for cutting, and other factors. This can help reduce loss in terms of material and time.

This is a Windows-based driver required for sending data from a computer to the machine. Be
sure to install it when you are using any of the programs just described.

MODELA Player

Dr.Engrave

3D Engrave

Virtual MODELA

Windows driver

Information on how to use the included software is found in online help for each program.

� See "4 Viewing Online Help."
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USB connector

Computer

USB cable

2 Installing and Setting Up to the Software

Windows XP

Installing the Windows Driver

1 Before you start installation and setup, make
sure the USB cable is not connected.

2 Log on to Windows as “Administrators.”

3 Insert the Roland Software Package CD-ROM
into the CD-ROM drive.
The setup menu appears automatically.

4 Turn on the processing machine.

5 Connect the machine using a USB cable.
The [Found New Hardware Wizard] appears.

Keep the printer and the computer unconnected until you carry out this installation operation. Failure to follow the
correct procedure may make installation impossible.

� See "2 Installing and Setting Up to the Software -- What to Do If Installation Is Impossible."
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2 Installing and Setting Up to the Software

6 Choose [Install the software automatically (Rec-
ommended)], then click [Next].
Installation of the USB driver starts automatically.

7 When the screen appears, click [Continue Any-
way].

8 Click [Finish].
This completes the installation.
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2 Installing and Setting Up to the Software

Installing the Software

1 Appear the setup menu of the Roland Software
Package.

2 Select the model name you are using.

Clear the [Windows Driver] check box, then click
[Install].
If you do not want to install a particular program, than
before you click [Install], clear the corresponding check
box.

3 The setup program starts. Follow the messages
to carry out setup and finish setting up the pro-
gram.
When the setup for one program finishes, the setup for
the next program starts. In the interval unit the next setup
starts, a dialog box showing the progress of processing is
displayed.

4 When all installation finishes, the screen shown
at right appears. Click [Close].

5 After returning to the menu screen for installa-
tion, click  .

6 Remove the CD-ROM from the CD-ROM drive.
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2 Installing and Setting Up to the Software

Windows 98 SE/Me/2000

1 Before you start installation and setup, make
sure the USB cable is not connected.

2 Log on to Windows. If you are installing under
Windows 2000, log on as “Administrators” right.

3 Insert the Roland Software Package CD-ROM
into the CD-ROM drive.
The setup menu appears automatically.

4 Choose the model name you are using, then
click [Install].
If there are programs you don't want to install, then clear
their check boxes before you click [Install].

5 The setup program starts. Follow the messages
to carry out setup and finish setting up the pro-
gram.
When the setup for one program finishes, the setup for
the next program starts. In the interval until the next setup
starts, a dialog box showing the progress of processing is
displayed.

6 Next, install the driver.

Select [Install]. From [Port] box, select [USB],
then click [Start].
Installation of the driver starts.

Keep the printer and the computer unconnected until you carry out this installation operation. Failure to follow the
correct procedure may make installation impossible.

� See "2 Installing and Setting Up to the Software -- What to Do If Installation Is Impossible."
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2 Installing and Setting Up to the Software

7 When all installation finishes, the screen shown
at right appears. Click [Close].

8 When the setup menu for installation reappears,
click .

9 Remove the CD-ROM from the CD-ROM drive.

10 Turn on the processing machine.

11 Connect the machine to your computer using a
USB cable.
The driver is automatically registered in your computer.

Computer

USB cable

USB connector
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2 Installing and Setting Up to the Software

What to Do If Installation Is Impossible

If installation quits partway through, or if the wizard does not appear when you make the connection with a USB cable,
take action as follows.

Windows XP/2000

1 If the [Found New Hardware Wizard] appears,
click [Finish] to close it.

2 For Windows XP

Click the [Start] menu, then right-click [My Com-
puter]. Click [Properties].

For Windows 2000

Right-click [My Computer] on the desktop. Click
[Properties].

3 Click the [Hardware] tab, then click [Device
Manager].
The [Device Manager] appears.

4 At the [View] menu, click [Show hidden devices].

5 In the list, find [Printers] or [Other device], then
double-click it.

When the model name you are using or [Un-
known device] appears below the item you se-
lected, click it to choose it.

6 Go to the [Action] menu, and click [Uninstall].

7 The screen shown at right appears.

Click [OK].

8 Close the [Device Manager] and click [OK].

9 Detach the USB cable connected to the printer.
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2 Installing and Setting Up to the Software

10 Restart Windows.

11 Uninstall the driver.

Carry out the steps from step 3 in "3 Uninstall
the Driver" to uninstall the driver.

12 Install the driver again according to the proce-
dure in"2 Installing and Setting Up to the Soft-
ware."

Windows 98 SE/Me

1 Unplug the USB cables from your computer.

2 Appear the setup menu of the Roland Software
Package.

3 Select only the [Windows Driver] check box, and
clear all other check boxes.

4 Click [Install].
The next screen appears.

5 Select [Uninstall], then click [Start].
When driver is deleted, the next screen appears.

6 Click [Yes] to restart the computer.

7 Install the driver again according to the proce-
dure in"2 Installing and Setting Up to the Soft-
ware."
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3 Uninstalling the Driver

Windows XP/2000

When uninstalling the driver, perform following operation.

1 Before you start uninstallation of the driver,
unplug the USB cables from your computer.

2 Log on to Windows as “Administrators” right.

3 Windows XP

From the [Start] menu, click [Control Panel].
Click [Printers and Other Hardware], then click
[Printers and Faxes].

Windows 2000

From the [Start] menu, click [Setting]. Then click
[Printers].

4 Click the the model name’s icon you are using.

From the [File] menu, choose [Delete].

5 When the screen prompting you to confirm de-
leting appears, click [Yes].

6 From [File] menu, click [Server Properties].
The next screen appears.
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3 Uninstalling the Driver

7 Click the [Drivers] tab. Choose the model name
you are using from the list, then click [Remove].

8 When the screen prompting you to confirm de-
leting appears, click [Yes].

9 Insert the Roland Software Package CD-ROM
into the CD-ROM drive.
The setup menu appears automatically.

10 At the setup menu, select only the [Windows
Driver] check box, and clear all other check
boxes.

11 Click [Install].
The next screen appears.

12 Select [Uninstall], then click [Start].
When driver is deleted, the next screen appears.

13 Click [Yes] to restart the computer.
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3 Uninstalling the Driver

Windows 98 SE/Me

When uninstalling the driver, perform following operation.

1 Before you start uninstallation of the driver,
unplug the USB cables from your computer.

2 Insert the Roland Software Package CD-ROM
into the CD-ROM drive.
The setup menu appears automatically.

3 At the setup menu, select only the [Windows
Driver] check box, and clear all other check
boxes.

4 Click [Install].
The next screen appears.

5 Select [Uninstall], then click [Start].
When driver is deleted, the next screen appears.

6 Click [Yes] to restart the computer.
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4 Viewing Online Help

For information on how to use the included programs and drivers, refer to the manuals in electronic format or the online
help.

From the [Start] menu, choose the program
you're using, then click [Help].
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Roland Software Package

インストールガイド

本書はRoland Software Packageのインストールガイドです。ソフトウェアのインストール方法やセッ
トアップ方法について書かれています。

R2-050823



このたびは本製品をお買い上げいただきまして、誠にありがとうございました。

○本製品を、正しく安全にご使用いただくため、また性能を十分理解していただくために、この取扱説明書を必ずお読みいただき、大切に保管してください。
　

○ご購入の際、「保証書」にお買い上げいただいた販売店の捺印、住所、購入年月日が記入されていることをお確かめの上、その保証書を大切に保管してくだ
さい。

○本書の内容の一部または全部を、無断で複写・複製することはできません。
○本製品の仕様ならびに本書の内容は、予告なしに変更することがあります。
○本製品および本書の内容について、万一ご不審な点や誤り、記載漏れなど、お気づきの点がありましたら、当社あてにご連絡ください。
○本製品の故障の有無にかかわらず、本製品をお使いいただいたことによって生じた直接ないし間接的な損害に対して、当社は一切の責任を負いません。
○本製品により作られた製作物に対して生じた、直接ないし間接的な損害に対して、当社は一切の責任を負いません。
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1 システム条件

ソフトウェアのシステム条件

USB接続のシステム条件

WindowsでUSB接続をするためには、次のシステム条件をすべて満たすコンピュータをお使いください。これ以外の
ものはサポートできませんのでご注意ください。

・USB接続ができるかどうかは、コンピュータの仕様に依存します。お使いになるコンピュータのUSBが正常動作す
るかどうかは、コンピュータメーカーにご確認ください。

・USBケーブルはシールドタイプを用い、長さは3mまでとしてください。また、USBハブなどは使用しないでくだ
さい。

OS

コンピュータの条件

基本ソフトウェア

パソコン本体

ドライブ

ディスプレイ

メモリ (RAM)

インストールに必要な
ハードディスク容量

インターフェイス

Windows 98 SE (Second Edition)/Me/2000/XP

Windowsが稼動するコンピュータ (Pentium プロセッサ以上を推奨)

CD-ROM ドライブ

256色以上表示可能なWindowsに対応しているもの (フルカラーを推奨)

32 MB以上を推奨

32 MB

USBポート

Windows 98 SE (Second Edition)/Me/2000/XP  (Windows 95、Windows NT4.0に
は対応していません)

1) Windows 98 SE/Me/2000/XPのいずれかが購入時にプレインストールされている
コンピュータ（これらをWindows Me/2000/XPにアップグレードした場合を含む）
2) コンピュータメーカーによってUSBの動作保証がされているコンピュータ
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2 ソフトウェアのインストール

付属ソフトウェアの概要

付属ソフトウェアの操作方法は、それぞれのソフトウェアのオンラインヘルプに記載されています。

� 参照 「4　オンラインヘルプの表示」

MODELA Player

Dr. Engrave

3D Engrave

Virtual MODELA

Windowsドライバ

自由な三次元形状を切削するためのソフトです。このソフト単体ではデザインできま
せん。MODELA 3D Design、MODELA 3D Textが含まれます。

ネームプレートなど、平面的な彫刻をするためのソフトです。書体には、Windowsに
登録したTrue Typeフォントが使えます。また、線文字（ストロークフォント）を内蔵
しています。画像の読み込みができ、ロゴなどの彫刻も可能です。名簿などのデータ
を読み込んで、たくさんの名札を次々に彫刻する機能もあります。

レリーフ（浮き彫り）をデザインして彫刻するソフトです。文字や図形、読み込んだ画
像に厚みをつけて立体化し、容易にレリーフを作成することができます。

3D Engrave やMODELA Playerでの切削を事前にシミュレートするソフトです。出
来上がりの形や切削にかかる時間などが確認できます。材料や時間のロスを少なくす
ることができます。

コンピュータから本機にデータを送るのに必要なUSBドライバとWindowsドライバ
が収録されています。

これらのソフトウェアは、XYZの3軸加工に対応しています。
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2 ソフトウェアのインストール

Windows XP

Windowsドライバのインストール

1 インストールの前に、USBケーブルが接続されて

いないことを確認してください。

2 "コンピュータの管理者" のアカウントでWindows

にログオンします。

3 Roland Software PackageのCD-ROMを、コ

ンピュータのCD-ROMドライブに挿入します。

しばらくすると、インストールメニュー画面が表示されま
す。

4 加工機の電源を入れ、起動します。

5 USBケーブルでコンピュータと接続します。

[新しいハードウェアの検索ウィザード]が表示されます。

このインストール作業をするまでは、本機とコンピュータを接続しないでください。手順を間違えると、インストールできなく
なることがあります。

� 参照 「2 ソフトウェアのインストール」の「インストールできない場合の対処」

USBケーブル

コンピュータ

USBコネクタ
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2 ソフトウェアのインストール

6 [ソフトウェアを自動的にインストールする（推奨）]

を選択し、[次へ]をクリックします。

ドライバのインストールが自動で始まります。

7 図の画面が表示された場合、[続行]をクリックしま

す。

8 [完了]をクリックします。

インストールが完了します。
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2 ソフトウェアのインストール

ソフトウェアのインストール

1 ソフトウェアのインストールメニュー画面を表示さ

せます。

2 お使いの機種名を選択します。

[Windows ドライバ]のチェックを外し、[インス

トール]をクリックします。

インストールしたくないソフトウェアがあれば、[インス
トール]をクリックする前にチェックを外してください。

3 セットアップ画面が開きます。[次へ]をクリックし、

メッセージに従ってインストールを進めます。

1つのソフトウェアのインストールが終わると、続けて次
のインストールが始まります。
次のインストールが始まるまでのあいだ、処理の途中経過
を表示するダイアログボックスが表示されます。

4 すべてのインストールが完了すると、図の画面が表

示されます。[OK]をクリックします。

5 インストールのメニューに戻ったら、 ボタンをク

リックします。

6 CD-ROMをCD-ROMドライブから取り出します。
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2 ソフトウェアのインストール

Windows 98 SE/Me/2000

1 インストールの前に、USBケーブルが接続されて

いないことを確認してください。

2 Windowsにログオンします。

Windows 2000にインストールするときは、"Ad-

ministrators"権限のアカウントでWindowsにロ

グオンします。

3 Roland Software PackageのCD-ROMディス

クをCD-ROMドライブに挿入します。

自動でインストールメニュー画面が表示されます。

4 お使いの機種名を選択して、[インストール]をク

リックします。

インストールしたくないソフトウェアがあれば、[インス
トール]をクリックする前にチェックを外してください。

5 ソフトウェアのセットアップ画面が開きます。[次

へ]をクリックし、メッセージに従ってインストー

ルを進めます。

1つのソフトウェアのインストールが終わると、続けて次
のインストールが始まります。
次のインストールが始まるまでのあいだ、処理の途中経過
を表示するダイアログボックスが表示されます。

6 続いてドライバのインストール画面になります。

[インストール]を選択します。 [ポート]メニューか

ら[USB]を選択し、[開始]をクリックします。

ドライバのインストールが始まります。

このインストール作業をするまでは、本機とコンピュータを接続しないでください。手順を間違えると、インストールできなく
なることがあります。

� 参照 「2 ソフトウェアのインストール」の「インストールできない場合の対処」
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2 ソフトウェアのインストール

7 すべてのインストールが完了すると、図の画面が表

示されます。

[閉じる]をクリックします。

8 インストールのメニューに戻ったら、 ボタンをク

リックします。

9 CD-ROMをCD-ROMドライブから取り出します。

10 加工機の電源を入れて、起動します。

11 USBケーブルでコンピュータと接続します。

コンピュータにドライバが自動で登録されます。

USBケーブル

コンピュータ

USBコネクタ
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2 ソフトウェアのインストール

インストールできない場合の対処

インストールが途中で中断してしまったり、USBケーブルを接続してもウィザードが表示されないときは、次のように
してください。

Windows XP/2000

1 [新しいハードウェアの検索ウィザード]が表示され

ていたら、[完了]をクリックして閉じます。

2 Windows XP の場合

[スタート]メニューをクリックし、[マイコンピュー

タ]をマウスの右ボタンでクリックします。[プロパ

ティ]をクリックします。

Windows 2000 の場合

デスクトップ上にある[マイコンピュータ]をマウス

の右ボタンでクリックします。[プロパティ]をク

リックします。

3 [ハードウェア]タブをクリックし、[デバイスマネー

ジャ]をクリックします。

[デバイスマネージャ]が表示されます。

4 [表示]メニューから[非表示のデバイスの表示]をク

リックします。

5 リストで[プリンタ]もしくは[その他のデバイス]を

探し、それをダブルクリックします。

その下に表示されたお使いの機種名または[不明な

デバイス]をクリックして選択します。

6 [操作]メニューから[削除]をクリックします。

7 図の画面が表示されます。

[OK]をクリックします。

8 [デバイスマネージャ]を閉じ、[OK]をクリックしま

す。

9 コンピュータからUSBケーブルを外します。
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2 ソフトウェアのインストール

10 Windowsを再起動します。

11 ドライバをアンインストールします。

次項「3 ドライバのアンインストール」の手順3 以

降にしたがって、ドライバをアンインストールして

ください。

12 「2　ソフトウェアのインストール」の手順に従って、

最初からインストールをやりなおします。

Windows 98 SE/Me

1 コンピュータからUSBケーブルを外します。

2 Roland Software Packageのインストールメ

ニュー画面を表示させます。

3 [Windowsドライバ]のみにチェックを入れ、その

他は外します。

4 [インストール]をクリックします。

図の画面が表示されます。

5  [アンインストール]を選択し、[開始]をクリックし

ます。

図の画面が表示されます。

6 [はい]をクリックして、コンピュータを再起動しま

す。

7 「2　ソフトウェアのインストール」の手順に従って、

最初からインストールをやりなおします。
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3 ドライバのアンインストール

Windows XP/2000

ドライバをアンインストールするときは、次の手順でおこなってください。

1 アンインストール作業をする前に、コンピュータか

らUSBケーブルを抜いておきます。

2 「コンピュータの管理者」または「Administrators

」権限のアカウントでWindows にログオンしま

す。

3 Windows XPWindows XPWindows XPWindows XPWindows XP

[スタート]メニューから[コントロールパネル]をク

リックします。[プリンタとその他のハードウェア]

をクリックし、[プリンタとFAX]画面を開きます。

Windows 2000Windows 2000Windows 2000Windows 2000Windows 2000

[スタート]メニューから[設定]をクリックします。

[プリンタ]画面を開きます。

4 お使いの機種名が表示されたら、クリックして選択

します。

[ファイル]メニューから[削除]をクリックします。

5 図の画面が表示されます。[はい]をクリックします。

6 [ファイル]メニューから[サーバーのプロパティ]を

クリックします。

次の画面が表示されます。



12 Roland Software Package インストールガイド

3 ドライバのアンインストール

7 [ドライバ]タブをクリックします。

お使いの機種名が表示されたらクリックして選択し、

[削除]をクリックします。

8 図の画面が表示されます。[はい]をクリックします。

9 Roland Software PackageのCD-ROMをCD-

ROMドライブに挿入します。

しばらくすると、インストールメニュー画面が表示されま
す。

10 [Windowsドライバ]のみにチェックを入れ、その

他は外します。

11 [インストール]をクリックします。

図の画面が表示されます。

12 [アンインストール]を選択し、[開始]をクリックしま

す。

ドライバが削除され、次の画面が表示されます。

13 [はい]をクリックし、コンピュータを再起動します。
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3 ドライバのアンインストール

Windows 98 SE/Me

1 アンインストールする前に、コンピュータから

USBケーブルを抜いておきます。

2 Roland Software PackageのCD-ROMをCD-

ROMドライブに挿入します。

しばらくすると、インストールメニュー画面が表示されま
す。

3 [Windowsドライバ]のみにチェックを入れ、その

他は外します。

4 [インストール]をクリックします。

図の画面が表示されます。

5 [アンインストール]を選択し、[開始]をクリックしま

す。

ドライバが削除され、次の画面が表示されます。

6 [はい]をクリックし、コンピュータを再起動します。
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4 オンラインヘルプの表示

付属ソフトウェアの操作方法の詳細は、オンラインヘルプを参照してください。

[スタート]メニューからお使いのソフトウェアを選

び、[ヘルプ]をクリックします。
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